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Introduction to Computing Skills:  

Excel 
All MSc programmes at Cass involve extensive use of IT through online materials, exercises and 

course work. Each student is therefore expected to be computer literate and be able to use packages 

such as Microsoft Office especially the data analysis spreadsheets. To level the playing field we 

provide computing skills refresher materials that are made available before the start of the first term 

in September. 
 

This material is presented in the form of self assessment online exercises so that each candidate can 

work through on their own. There will also be a weekly face to face session to go through the 

Induction excel exercises. These sessions will be offered as optional computing skills exercises 

during the first term only. 
 

The key objective of this induction module is to provide each student with a check list of 

minimum computer data analysis skills that are essential before commencing an MSc programme 

at Cass. These basic skills include: 
 

1. Functions and Keyboard skills 
 

2. Core Functions (i) Logical (ii) Maths & Trig (iii) Statistical and (iv) Financial 
 

3. Inputting formulas and functions 
 

4. Financial Calculations 
 

 Time value of money


 Project appraisal techniques


 Sensitivity analysis


 Regular payments eg annuities


 Optimisation


 Asset pricing and valuation


5. Descriptive statistics 
 

6. Creating Charts 
 

7. Statistical distributions 
 

8. Hypothesis testing 
 

9. Basic econometric analysis e.g regression model 
 

10. Macros e.g Visual basic 
 

This handbook contains a brief introduction to each of these concepts and also provides data 

to enable you to practice solving these using excel functions. The data can be accessed on 

your induction website 
 

You are strongly encouraged to attend the excel lab sessions and attempt these exercises during 

weekly sessions shown on your timetable Should you need further clarification or help please feel 

free to contact your instructor Oliver Manyemba by email at Oliver.Manyemba@city.ac.uk 
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What is Excel? 
 

Excel is one of the leading spreadsheet packages, with a wide range of capabilities, 

including financial analysis, statistics, graphics, database and sensitivity analysis functions. 

To activate Excel, click Start button and point to Programs and click on Microsoft Excel. 
 

After displaying the Excel logo, you are presented with a screen similar to any Windows 
screen, with the usual maximise/minimise buttons, title bar, scroll bars and menu bar. We 
will be reviewing most of the menu items, the options under each item and several 

shortcuts (tools) that will facilitate your work. At the end of the instruction you should be 
able to put together a relatively sophisticated spreadsheet, use a series of financial 

analysis tools, perform a sensitivity analysis, produce graphs and use the program's 
optimisation utility. You will also be able to enhance the appearance of your work, using 
different types of fonts, letter sizes and cell outlines.  
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The window borders  
A box in the top left hand corner of the spreadsheet shows the reference of the cell pointer 
(e.g. A7). A box to the right of the cell-pointer reference displays the contents of the cell-
pointer (e.g. 26). The area that contains both boxes is called "Formula Bar". 
The bottom left hand corner of the spread sheet contains a box showing the spreadsheet 

status. The status "Ready" indicates that it is possible to enter data into the cell; the 

status "Cell:" or "Calculating Cells:" indicates that the computer is processing and is not 

yet ready; the status "Enter" indicates that data is currently being entered into the cell.  
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1. Menu Items 
 
 
 

File 
 

click this item or press <Alt+F> for options regarding printing set-up, printing, 

opening, closing and saving files 
 

Edit 
 

click this item or press <Alt+E> to cut, copy or paste an item, insert/delete rows, 

columns, cells or entire sheets and find cells with specific text or numerical input 
 

View 
 

click this item or press <Alt+V> change the appearance of the toolbars and the view 

ratio, i.e. the number of cells that you can see on your desktop at any time 
 

Insert 
 

click this item or press <Alt+I> in order to insert cells, rows, columns in your 

spreadsheet; new worksheets, charts or modules in your file; or insert 

functions, pictures and OLE objects 
 

Format 
 

click this item or press <Alt+O> to change the way text and numbers look. You can 

make a number be displayed with decimal places, preceded by a currency unit, or 

displayed as a percentage. You also use this option to change the alignment and the 

orientation of text, outline or shade a cell or a group of cells 
 

Tools 
 

click this item or press <Alt+T> to use facilities like spell-checking, the Solver, the 

Goal Seek and Scenario analyses and to run, record or edit macros 
 

Data 
 

click this item or press <Alt+D> for database functions, when you use Excel as a 

database. A very useful option in this submenu Data|Table, which is used for one-

way or two-way sensitivity analysis 
 

Window 
 

click this item or press <Alt+W> to view other windows in Excel (if you have 

opened more than one file) and to arrange windows on the desktop 
 

Help 
 

click this item or press <Alt+H> to get information on various Excel items. This option 

is also useful for Lotus users who wish to switch to Excel, as it gives quite a lot of 

information on how to replace the classic Lotus menus with the mouse-driven Excel 

menus 
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2. Keyboards 
 

Excel has the following commonly used key operations: 
 

Arrow keys  
 

 

Move the cell-pointer 
 

Tab  
 
 
 

 

Move the cell-pointer right 
 

Shift-Tab  
 
 
 

 

Move the cell-pointer left 
 

Home  
 
 
 

 

Move to the left most sell in the row (column A) 
 

Ctrl-Home  
 
 
 

 

Move to the top left hand cell in the spreadsheet (A1) 
 

Insert  
 
 
 

 

Toggle Typeover mode 
 

End  
 
 
 

 

Move to the end of a range 
 

Page-up  
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Move the window up by the screen height 
 

Page-down  
 
 
 

 

Move the window down by the screen height 
 

2.1. Function keys 
 

Excel has a number of function keys. The commonly used keys are as follows:  
 
 

 

Access the help facility  
 
 

 

Activate the formula bar  
 
 

 

Display the Paste Name dialog box if there are names defined  
 
 

 

Toggle a reference between relative, absolute and mixed  
 
 

 

Go To command  
 
 

 

Next pane  
 
 

 

Check spelling  
 
 

 

Turn extend mode on or off  
 
 

 

Calculate all sheets  
 
 

 

Activate the bar menu 
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Insert new chart sheet  
 
 

 

Save file 
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3. Excel Menu Ribbon 
 

3.1. Overview of Menu Ribbon 
 

On the menu ribbon you can have different sets of toolbars. Excel is configured by default 

to show the menu ribbon with 7 tabs while several other combinations can be selected, 

depending on the user's requirements. 

 

3.2. Frequently Used Commands  
 
 

 

New 
 

Creates a new document based on 

the default template. 
 

Open 
 

Opens or finds a file. 
 

Save 
 

Saves the current file with its current 

file name, location and file format. 
 

Print 
 

Prints the active file or selected items. 
To select print options, on the Print 

 

Preview 
 

Displays a screen shot of what the 

document will look like when printed. 
 
 
 
 
 
 
 

 

Spelling  
 

Checks spelling in the active document, file, workbook or item. 
 

Cut  
 

Removes the selection from the active document and places it on the clipboard. 
 

Copy  
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Copies the selection to the clipboard. 
 

Paste  
 

Inserts the contents of the clipboard at the insertion point and replaces any selection. 

This command is only available if you have copied an object, text or contents of a cell 
 

Format Painter  
 

Copies the format from a selected object or text and applies it to the object or text 

you click. 
 

Undo  
 

Reverses the last command or deletes the last entry you typed. To reverse more than one 

action at a time use the arrow next to the button 
 

Redo  
 

Reverses the action of the Undo command. 
 

AutoSum  
 

Adds numbers automatically with the sum function. 
 

Paste Function  
 

Displays a list of functions and their formats and allows you to set values for arguments. 
 

Sort Ascending   

Sort Descending  
 

Sorts the selected items in ascending or descending order alphabetically, numerically, or 

by date using the column that contains the insertion point 
 

Chart  
 

Starts the Chart Wizard which guides you through the steps for creating an 

embedded chart on a worksheet or modifying an existing chart. 
 

Map  
 

Creates a map based on the selected data. The data should contain geographic 

references such as abbreviations of countries or states. 
 

Drawing  
 

Displays or hides the Drawing toolbar Zoom Enters a magnification between 10 and 200 

percent to reduce or enlarge the display of the active document 
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Office Assistant  
 

The Office Assistant provides help topics and tips to help you accomplish your tasks. 
 

3.3. Formatting Commands 
 

 

Font  
 

Changes the font of the selected text and numbers 
 

Font Size  
 

Changes the size of the selected text and numbers. 
 

Bold  
 

Makes selected text and numbers bold. 
 

Italic  
 

Makes selected text and numbers italic. 
 

Underline  
 

Makes selected text and numbers underlined. 
 

Align Left  
 

Aligns the selected text, numbers or inline objects to the left. 
 

Align Centre  
 

Aligns the selected text, numbers or inline objects to the centre. 
 

Align Right  
 

Aligns the selected text, numbers or inline objects to the right. 
 

Merge & Centre  
 

Combines two or more selected adjacent cells to create a single cell 
 

Currency Style  
 

Applies the currency formatting style to the selected cells 
 

Percent Style  
 

Applies the percent formatting style to the selected cells 
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Comma Style  
 

Applies the comma formatting style to the selected cells. 
 

Increase Decimals  
 

Increases the number of digits displayed after the decimal point in the selected cells 
 

Decrease Decimals  
 

Decreases the number of digits displayed after the decimal point in the selected cells. 
 

Decrease Indent   

Increase Indent  
 

Reduces or Increases the indentation of the selected cell or range. 
 

Borders  
 

Adds a border to the selected cell or range. 
 

Fill Colour  
 

Adds, modifies or removes the fill colour or the fill effect from the selected object. 
 

Font Colour  
 

Formats the selected text with the colour you click. 
 

Increase Font Size   

Decrease Font Size  
 

Increases or decreases the font size of the selected cell(s) to the 
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4. Data Input 
 

There are two main different types of cell entries: 
 

text entries 
 

numerical (numbers, formulas or functions) entries 
 

To insert text in a cell, click on the cell and then start typing your text straight 

away. If your text contain numbers, Excel will still read it as text, irrespective 

of the position of your numbers. 
 
 

To insert numbers, click on the cell and type in your number. If it is a single 

number and not a formula, Excel will read it as a number straight away. If it is, 

however, a series of mathematical operations (addition, subtraction, etc.), text 

will be displayed instead of the result of the operation. To solve this problem 
type = or + at the beginning of the input (Excel will insert the = sign even if 

you put +. The special characters E, e, %, - and . can be used and will be 

automatically recognised. 
 
 

Excel will also format the cell automatically to display numbers as percentages, as 

multiples of 10 raised to a power, etc. If you want to edit the contents of a cell, 

double-click on the cell itself or click on the cell contents in the reference area 

(Formula Bar). When you do so two buttons, a cross and a checkmark, will appear 

between the cell address and the contents. When you finish 

changing the cell contents hit or click on the checkmark. If, 

however, you change your mind and want to keep the cell contents intact, hit 

or click on the cross 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 15 



MSc Induction Programme  Introduction to Advanced Excel 

Oliver Manyemba August 2017 

5. Formatting 
 

Formatting can be applied to a single cell, a group (range of cells), the entire 

spreadsheet, or even to part of the input of a cell. To apply any type of formatting, you 

need to either: 
 

click on the cell (for a single cell)  
 
 
 
 
 
 
 
 

 

or highlight a range of cells ('click & drag' with your mouse)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

or click on the top left grey button of the spreadsheet (to select the entire spreadsheet)  
 
 
 
 
 
 
 
 
 

There are several types of format attributes you can change: 
 

number format (display as a percentage, with a fixed number of decimal 
places, with a currency prefix, etc.) 
alignment (flush left, flush left or centre inside the cell) 

 

font (change typeface, font size, font colour, underline, embolden, etc.) 

border (apply lines around a single cell or a range of cells) 
 

patterns (apply a colour or pattern on the cell background) 
 

you can also change the width of columns and height of rows 
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5.1. Number 
 

There are several ways you can display numerical cell input. You may wish to display all 

your figures with the same number of decimal places, as a percentage, with currency 

symbols, with negative numbers in red, etc. There two ways to do so: 

 

The long way... 
 

The advantage of this method is that you can fully customise the format attributes you 

apply to your cells and you can even create your own formatting styles. 
 

Step 1: Select the cells you want to format 
 

Step 2: Select Format | Cells from the menu bar in order to display the window shown 

below. Click on the Number tab and use one of the available numerical formats, e.g. 

currency, percentage, accounting, etc. 
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Step 3: Specify the attributes available for each style. In the example above, for instance, 

you can change the number of decimal places, change the currency symbol that is used 

and select an alternative way to display negative numbers. 

 

The short cut... 
 

You can use any of the buttons on the formatting toolbar The drawback 
is that the currency, percentage and comma styles apply preset number formats. For 
example, the currency format uses the default currency (e.g. $ in a PC with US as the 

default country), comma separated thousands and 2 decimal places. You can, of course, 
make further changes to the number format, as discussed above. 

 

5.2. Alignment 
 

Excel automatically aligns any text or numbers you insert in a cell. 
 

Text is by default aligned to the left, whereas numbers are aligned to the right. 

 

The long way... 
 

You may change the alignment of the cells, as well as a few more attributes,  
by selecting Format | Cells and then clicking on the Alignment tab (displayed below) 
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Apart from the straightforward horizontal alignment (left, centre or right),  
you can also change the vertical alignment (top, middle or bottom) of the cell input. 

You can also changing the orientation of text or numbers by clicking and dragging  
on the red point of the 'clock dial' displayed above, or change the number of degrees below the dial. 

 

The short cut... 
 

Use any of the alignment buttons on the formatting toolbar . 
The fourth button on this bar performs an action called 'merge & centre'. 
You can use this if you highlight more than one cells. 
The selected cells are merged in one cell and their input is centred in the new single cell.  
 
 
 
 
 
 
 
 
 
 
 
 

 

5.3. Font 
 

There are several font attributes you can change: typeface, style, size, underlining, colour 

and use effects such as strikethrough, superscript or subscript. 

 

The long way... 
 

Select the cell or cells whose font attributes you want to change. Then click on Format | 

Cells and select the Font tab. The window displayed below appears on the screen. 
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Change any of the attributes you wish and then click OK. 

 

The short cut.. 
 

Use any of the buttons on the formatting toolbar to 

change the typeface and size of cells, or make text appear bold, italicised or underlined. 

 

5.4. Border 
 

Cells in your spreadsheet appear as small rectangles with grey borders (called 

'gridlines'). These gridlines can be printed if you want, but instead of them you can 

apply your own customised borders. You can apply borders on one or more sides of 

each cell (or range of cells). A border can be a solid, dashed or double line, in black or 

in any other colour. 

 

The long way... 
 

From the menu select Format | Cells and then click on the Border tab. You can 

then change any of the attributes you see displayed below. 
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The short cut... 
 

Use the button. Click on the small arrow on the right  
hand side to display the dropdown menu on the right and then 

select any of the available preset borders. The dotted border 

on the top left corner of the dropdown menu simply removes 

all borders from the selected cell or cells. 
 

 

5.5. Patterns 
 

In addition to changing the colour of a cell's contents, you can also change the colour of 

its background. You may also choose to use a pattern instead of a solid colour. This is 

very useful when the final output will be printed in black & white only, whereby patterns 

are easier to read than different shades of grey (which is what colours look like in a black 

& white printout). 

 

The long way... 
 

From the menu bar select Format | Cells... and click on the Patterns tab to get the 

dialogue box displayed below. 
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The example below shows the appearance of text after changing the background colour 

to yellow and the font colour to red. 
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6. Printing 
 

6.1. Page Layout 
 

You can control the appearance, or layout, of printed worksheets by changing options in 

the Page Setup dialog box. A worksheet can be printed in portrait or landscape orientation, 

and you can use different sizes of paper. Worksheet data can be centred between the left 

and right margins and the top and bottom margins. You can change the order of the printed 

pages, as well as the starting page number. 
 

Change the page orientation 
 

Step 1: Click Page Layout. 
 

Step 2: Under Orientation, click Portrait or Landscape. 
 

Set the size of the paper 
 

Step1: Click Page Layout. 
 

Step 2: Select Size command, click the size of paper you want. 
 

Centre worksheet data on the printed page 
 

Step 1: On Page Layout, click Margin. 
 

Step 2: To centre worksheet data horizontally on the page between the left and right 

margins, select the Horizontally check box under Centre on page. 
 

To centre worksheet data vertically on the page between the top and bottom margins, 

select the Vertically check box under Centre on page. 
 

Create Headers and Footers 
 

Step 1: On Insert tab, select Header and Footer command. 
 

Step 2: Select from a variety of existing Headers/Footers or create your own by 

pressing either the Custom Header or the Custom Footers button 

 

6.2. Print the active sheets, a selected range, or an entire workbook 
 

If the worksheet has a defined print area, Microsoft Excel will print only the print area. If 

you select a range of cells to print and then click Selection, Microsoft Excel prints the 

selection and ignores any print area defined for the worksheet. 
 

Step 1: On the File menu, click Print. 
 

Step 2: Under Print what, select the option you want. 
 

Step 3: Check the printout using the print Preview command, by simply clicking the 

bottom left corner button on the dialog box 
 

Step 4: Click the Print button which appears on the top of the screen. 
 
 

If you want to print more than one sheet at the same time, select the sheets before you print. 
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7. Cell Manipulation 
 

7.1. Selecting or highlighting cells 
 

Using your mouse you can point to a corner of the area you want to select and drag it 

to the opposite corner. If you want to highlight a part of a column (row), point to the first 

cell and drag it to the last one. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If you want to highlight the entire column (row), click on its header (row header). 
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To select the entire workbook click on they grey button where the row and 
column headings meet. 
To highlight non-adjacent ranges of cells, click and drag to highlight the first range, then 

press and hold the <Ctrl> key every time you highlight an additional range. You can use 

the same procedure to highlight non-adjacent columns and rows, or any combination of 

any of the above. 
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7.2. Copying and moving cells 
 

To copy the contents of a cell or a range of cells to another cell or range of cells: 
 

Highlight the cell(s) 

 

Press the Copy button on the toolbar 
 

Point to the cell or select the range of cells where you want to paste your 

selection Press the Paste button. 

Point to the cell which contains the data you want to copy 
 

Point to the dot at the bottom right-hand corner of the cell, where the 

cursor changes from a white to a black crosshair 
 

Click and drag to the appropriate position and then release the mouse 

button When you want to move your cells from one part of the workbook to another: 

Highlight the cell(s) 
 

Press the Cut button on the toolbar. 
 

Point to the cell or select the range of cells where you want to paste your 

selection. Press the Paste button. 

 

Highlight the cell(s) 
 

Point to any of the edges of the highlighted cells; you will see your pointer change 

from a white cross to an arrow 
 

Click and drag to the appropriate position and then release the button 

 

7.3. Filling cells 
 

You can fill a series of cells with consecutive numbers, dates etc. To do this: 
 

Put a start value in a cell 
 

Click Edit | Fill | Series 
 

Fill in the step and stop values, and the type of series (linear, growth etc.) 

Alternatively: 

Type in the first and second value of the series (linear growth will be assumed) 

Highlight both values 
 

Point to the bottom right-hand corner of the cell, where the cursor changes from 

a white to a black crosshair 
 

Click and drag to the appropriate direction and then release the button 
 

Excel has a neat shortcut to fill in standard series, such as days of the week (Monday, 
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Tuesday, etc.) and months of the year (January, February, etc.). In addition, you may also 

create series of the form Year 1, Year 2, .... or Quarter 1, Quarter 2, .... and so on. Simply: 
 

Type the first item in the series, e.g. Monday (the abbreviation Mon is also 

acceptable) 
 

Select the cell, point at the bottom right corner of it and drag down (right) to create 

the series in a column (row) 
 

To expand (reduce) the series, highlight all of it, point at its bottom right corner 

and drag up (down) or to the left (right) to reduce (expand) it 
 

Watch a screenshow of autofilling days of the week. 

 

7.4. Inserting and deleting cells, rows and columns 
 

You will often need to create more space on your spreadsheet. This can be done by 

inserting or deleting rows or columns. To do so: 
 

Select a column (row) by simply clicking on its header 
 

Right-click on the header of the column (row); a pop-up menu appears 
 

Click Insert on the pop-up menu to insert a column (row) or Delete to delete it 
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8. Entering Formulas 
 

Probably the most important feature of a spreadsheet is the ability to perform algebraic 

operations not only between pure numbers, but between cells that contain numbers. 

Although not apparently useful for a small number of trivial calculations, the facility of using 

formulas is extremely efficient when a large number of routine calculations is necessary, or 

when numerical inputs are bound to change. Let's start at the beginning, however. 

 

8.1. Using Excel as a 'calculator 
 

You can use Excel to perform simple or complex calculations. Just precede any numerical 

operations with the = sign and the type numbers with any of the 5 common operators: + 

(addition), - (subtraction), * (multiplication), / (division), ^ (power). 
 

As in simple mathematics, the order of precedence for the operators is ^ * / + -. If you need 

to change this order, you need to enclose numbers in parentheses. For example: 
 

=8*2+3 gives you a result of 19, whereas  
=8*(2+3) gives you a result of 40. 
 

Calculations can be as complicated as you may wish, provided that the total 

characters (numbers and operators) typed in any single cell are not more than 256. 

 

8.2. Using cell references 
 

The beauty of a spreadsheet is the facility it provides to: 
 

recalculate numerical operations every time one of the numbers in your 

calculations change; and 
 

repeat long series of essentially the same routine calculations. 
 

To achieve this you need to instruct Excel to perform calculations making reference to cell 

contents, rather than using the pure numbers themselves. This way, every time you change 

the contents of the referenced cells Excel will simply recalculate the new result of your 

numerical calculations. 
 

Reference can be made to cells in a spreadsheet by using the convention of column (letter) 

followed by row (number). For example the reference A7 refers to the origin cell at column A 

and row 7 . The reference B7 refers to the origin cell at column B and row 7. Formulae can 

then be constructed by using a series of cell references. For example, when we have to 

multiply the value in cell A7 by a number, say 7, we can use the following formula: 
 

=A7*7 
 

If we wanted to add the contents of cell A7 to the contents of cell B7 and then multiply 

the result by 10, we should write the following formula: 
 

=(A7+B7)*10 

 

8.3. Reference to a range of cells 
 

Sometimes you need to perform mathematical calculations using a range of cells rather 
 

 29 



MSc Induction Programme  Introduction to Advanced Excel 

Oliver Manyemba August 2017 

than using one single cell. Such a range could be either a contiguous range of cells or a 

rectangle range of cells. 
 

A contiguous range of cells in a row or a column 
 

The range A1:A6 refers to the cells A1,A2, A3, A4, A5 and A6. The sum of the latter cells 

can be calculated with the formula: 
 

=SUM(A1:A6) 
 

A rectangular block of cells within the spreadsheet 
 

The range B2:C3 refers to cells B2, B3, C2 and C3. The average of the latter cells can 

be calculated using the following formula: 
 

=AVERAGE(B2:C3) 
 

More sophisticated cell manipulations (e.g. adding different ranges of cells, multiplying a 

range of cells by another range of cells, dividing a range of cells by a single cell etc.) 

can also be easily constructed using the same principle. 

 

8.4. Relative cell addresses 
 

Once you have created a formula, you can easily copy it in order to perform exactly the 

same calculation for a different set of cells with the same characteristics. 
 

Say, for example, that you have to calculate the Operating Profit in the 

spreadsheet pictured below, which is derived as follows: 
 

Operating profit = Revenue - Production cost - Advertising 
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9. Copying Formulas  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

On the spreadsheet you would need to put the following formula in cell B5: 
 

=B2-B3-B4 
 

Say now that needs to repeat this operation for all months until June. Instead of retyping 

the formula over and over again, simply copy cell B5 and copy it across in cells C5...G5. 
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The picture above shows the result of this operation and also displays the formulas 
entered instead of the numerical results. Notice cells B3...G3 and B5...G5. Excel has not 
copied exactly the same cell addresses, but the relative cell addresses that perform the 
same operation. As a result, every month you get the correct operating profit by 
subtracting the month's production cost and advertising from the month's revenue. The 
formula effectively instructs Excel to take the content of the cell 3 rows above and from it 
subtract the contents of the cell 2 rows above and those of the cell 1 row above. Try 
copying this anywhere in the spreadsheet and you will get the same result. 

 

9.1. Fixed cell addresses 
 

Sometimes you may need to perform a calculation between a number of successive 

cells and a single other cell. Say, for example, that you need to calculate the annual 

interest rate on the outstanding amount of a loan, given that the interest rate remains the 

same throughout the loan repayment. 
 

This is what happens when you use the copy+paste method used above:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The results in column C are wrong, except that in cell C5. This is because Excel 

has copied the relative cell addresses as you can see in the picture below. 
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instead of this, you need to multiply each of the cells B5...B9 with cell B2. You can either 

do this manually for every single cell. If you work smartly, however, you can avoid extra 

work by using a fixed reference for cell B2 when you first type your formula in cell C5 

and then copy it down. This you can do by preceding the cell co-ordinates with the $ 

symbol, i.e. $B$2. See how this looks in the picture below. 
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And now see how you get the correct results!  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fixing a cell address can be done as described above or by using the F4 key after typing the 

address you want to fix. F4 can be used to toggle among 4 different versions of the 
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cell address. For cell B2 it could be: 
 

$B$2 (both co-ordinates are fixed) 

$B2 (only the column is fixed) 
 

B$2 (only the row is fixed) 
 

B2 (nothing is fixed, back to relative address) 
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10.  Functions 
 

Excel offers a series of functions for a wide range of needs. Functions are classed as: 
 

Logical 
 

Mathematical & trigonometric 
 

Statistical 

Financial 
 

Time & date 

Database 

Text 
 

Lookup & reference 
 

Information 
 

Because it is difficult to remember all but a few common functions, Excel provides a 

menu choice that lets you paste a function into a cell. To activate the option: 
 

Select Insert | Function or press the Paste Function button on the toolbar 
 

From the pop-up window select the function you wish to use; at the bottom of 

the pop-up window more information on the function's syntax is displayed 
 

Click on OK to insert the function 
 

Excel will not automatically recognise functions unless you put = at the beginning (you 

don't need to type = when you use the Paste Function button) 
 

The following dialogue box is now displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Define the arguments (arguments specify individual cells or cell ranges that contain 

parameters needed for the calculation performed by the function) and click OK. 
 

Several functions also can (or can only) be inserted as array formulas. Array formulas 

can be described as multiple value formulas and they differ from single-value formulas 
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because the can produce more than one result. For this reason they are usually (but 

not always) collectively inserted in a range of cells. 
 

Three such functions are FREQUENCY, MMULT and MINVERSE, which are covered 

under statistical (FREQUENCY) and math & trig (MMULT and MINVERSE) functions. 
 

To insert a function in an array: 
 

Highlight the range where it is going to be inserted 
 

Type the function and its arguments 
 

Insert the function in the highlighted range of cells by simultaneously pressing 

Ctrl+Shift+Enter. Array functions are automatically enclosed in braces {}, which 

you cannot insert manually. Any attempt to do so will result in Excel reading the 

function 

 

10.1. Logical Function 
 

Some of the Logical functions include: 
 

AND(logical1, logical2,...): Returns the value TRUE if all arguments are true, 

and FALSE if any of the arguments is false 
 

OR(logical1, logical2,...): Returns TRUE if any of the arguments is true, 

and FALSE if all of the arguments are false 
 

IF(logical_test, value_if_true, value_if_false): Performs a logical test first. If 

the test returns TRUE it performs the first operation, otherwise it performs the 

second one. An example of where you could use IF statements is if you were 

asked to calculate tax charges on profits, taking into account that losses 

generate zero tax instead of negative tax (tax return) 
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Logical functions make use of a series of logical operators. These are: 
 

> greater than 
 

>= greater than or equal to 
 

< less than 
 

<= less than or equal to 
 

<> not equal to 
 

 

Example 
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10.2. Math & Trig Functions 
 

Some of the Mathematical functions include: 
 

INT(number): Rounds a number down to the nearest integer 
 

LN(number), LOG10(number): Returns the natural/decimal logarithm of a number 
 

COMBIN(number, number_chosen): Returns the number of combinations for a given 

number of objects; it is based on the formula n!/k!(n-k)! where n is the total number 

of objects and k is the number of objects that are chosen each time 
 

MDETERM(array): Returns the matrix determinant of an array 
 

MINVERSE(array): Returns the matrix inverse of an (nxn) array and has to be inserted 

as an array formula (i.e. by pressing simultaneously Ctrl+Shift+Enter) in a (nxn) range 
 

MMULT(array1, array2): Returns the matrix product of two arrays (mxk and kxn) and 

has to be inserted as an array formula in a (mxn) range 
 

PRODUCT(number 1, number 2, ...): Calculates the product of its arguments, which can 

be numbers or cell addresses 
 

RAND(): Generates a random number between 0 and 1 
 

ROUND(number, number_digits): Rounds a number to a specified number of decimal 

places 
 

SQRT(number): Returns the positive square root of a number 
 

SUM(number1, number2, ...): Adds the sum of its arguments, which can be numbers 

or cell addresses. 
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10.3. Statistical Functions 
 

Some of the Statistical functions include: 
 

AVERAGE(number 1, number 2, ...): Returns the average of its arguments; if a 

range is specified, blank cells are omitted form calculation, but cells with 0 

values do get included 
 

CORREL(array1, array2): Returns the correlation coefficient between two 

data sets 
 

FREQUENCY(data_array, bins_array): Returns the frequency distribution of a 

data set as an array; it has to be inserted as an array formula and the 

bins_array must contain the lower ends of the intervals 
 

GEOMEAN(number1, number2, ...): Returns the geometric mean of 

its arguments 
 

KURT(number1, number2, ...): Returns the kurtosis of the data set 
 

MEDIAN(number1, number2, ...): Returns the median of its arguments 
 

MIN/MAX(number1, number2, ...): Returns the minimum/maximum value in a 

list of values 
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MODE(number1, number2, ...): Returns the most common value in a data set 
 

SKEW(number1, number2, ...): Returns the skewness of a distribution 
 

STDEV(number1, number2, ...): Estimates the standard deviation based on 

a sample 
 

STDEVP(number1, number2, ...): Estimates the standard deviation based on 

the population 
 

VAR(number1, number2, ...): Estimates the variance based on a sample 
 

VARP(number1, number2, ...): Estimates the variance based on the population 
 

PERMUT(number, number_chosen): Returns the number of permutations 

(where internal order is important) for a given number of objects; it is based on 

the formula n!/(n-k)!, where n is the total number of objects and k is the 

number of objects that are chosen each time 
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There are also numerous other functions that calculate probability mass functions 
and cumulative functions for a number of distributions, such as the binomial, normal, 
Chi-square, F and several others. 
There are also several statistical functions that are available as add-ins, such as the 

z-test, t-test, chi-square test, and the F-test. 

 

10.4. Financial Functions 
 

Financial functions perform common business calculations, such as determining 

the payment for a loan, the future value of an investment, and the values of bonds 

or coupons. 
 

Common arguments for the financial functions include: 
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DB(cost, salvage, life, period): Returns the depreciation of an asset for 

a specified period using the fixed-declining balance method 
 

SLN(cost, salvage, life): Calculates the straight-line depreciation for an asset 

for one period, given the cost of the asset, its salvage value and its life 
 

PMT(rate, nper, pv): Returns the periodic payment for an annuity, given the 

interest rate per period, the number of periods and the present value of the 

series of future payments 
 

PPMT(rate, per, nper, pv): Returns the payment on the principal for an 

investment for a given period; in effect it returns the principal portion of 

the annuity calculated by the PMT function 
 

IPMT(rate, per, nper, pv): Returns the interest payment for an investment for a 

given period (per) which must be in the interval [1, nper]; in effect, it returns 

the interest portion of the annuity calculated by the PMT function 
 

IRR(values, guess): Calculates the internal rate of return for a series of cash 

flows; you need to specify the series of values and a guess for the discount 

rate which Excel will use as a starting point for the subsequent calculations 
 

MIRR(values, finance_rate, reinvest_rate): Returns the internal rate of return 

where positive and negative cash flows are financed at different rates; 

finance_rate applies to negative cash flows and reinvest_rate applies to 

positive cashflows 
 

NPV(rate, value1, value2, ...): Calculates the sum of a series of discounted 

cash flows; you need to determine the discount rate and the series of values 

that represent the cash flows. Do not include the capital outlay in year 0 in the 

function's arguments; subtract from the NPV of the cash inflows  
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IRR 
 

Suppose you want to start a restaurant business. You estimate it will cost $70,000 to 

start the business and expect to net the following income in the first five years: $12,000, 

$15,000, $18,000, $21,000, and $26,000. 
 

Cells B3:B8 contain the following values: $-70,000, $12,000, $15,000, 

$18,000, $21,000 and $26,000, respectively. 
 

To calculate the investment's internal rate of return: 
 

after four years: IRR(B3:B7) equals -2.12 percent 
 

after five years: IRR(B3:B8) equals 8.66 percent 
 

after two years, you need to include a guess: IRR(B3:B5,-10%) equals -

44.35 percent 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

i 
 
 
 
 
 
 
 
 
 

 

NPV 
 
 

 

Example 1 
 

Suppose you're considering an investment in which you pay $10,000 one year from 

today and receive an annual income of $3,000, $4,200 and $6,800 in the three years 

that follow. 
 

Assuming an annual discount rate of 10 percent, the net present value of 

this investment is: =NPV(10%,-10000,3000,4200,6800) equals $1,188.44 
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Example 2 
 

In the preceding example, you include the initial $10,000 cost as one of the values, 
because the payment occurs at the end of the first period. Consider an investment 

that starts at the beginning of the first period. Suppose you're interested in buying a 
shoe store. The cost of the business is $40,000, and you expect to receive the 
following income for the first five years of operation: $8,000, $9,200, $10,000, 

$12,000, and $14,500. The annual discount rate is 8 percent. This might represent the 
rate of inflation or the rate of return of a competing investment. 
 

If the cost and income figures from the shoe store are entered in B7 through 

B12 respectively, then net present value of the shoe store investment is given 

by: =NPV(8%, B8:B12)+B7 equals $1,922.06 
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Example 3 
 

In the preceding example, you don't include the initial $40,000 cost as one of the 
values, because the payment occurs at the beginning of the first period (or the end of 

the previous period, year 0). Suppose your shoe store's roof collapses during the 

sixth year and you assume a loss of $9000 for that year. The net present value of the 

shoe store investment after six years is given by: =NPV(8%,B19:B23,-9000)+B18 

equals - $3,749.47 
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11.  Sensitivity Analysis 
 

One of the most useful features of a spreadsheet is the ability to perform a 

sensitivity analysis in order to find out what happens to one or more end results of a 

long calculation when one or two of the original assumptions change. You can 

perform a one- or two-way sensitivity analysis, depending on whether you vary one 

or two assumptions at a time. 
 

To run a sensitivity analysis, click and drag the mouse to highlight the range, including 
the reference cell and sensitivity values for one or two of the variables. This range is 

known as the ‘table range’. The reference cell must be linked through a formula to an 
‘input cell’ which is the one that will be varied to see the effects on the reference cell. 

To initiate the sensitivity analysis select Data Tab => What if Analysis => Data Table. 
Then the pop-up dialogue box will ask you to specify one or two input cells. When 
performing a one-way sensitivity, you need only specify one input cell, either column or 

row. For two-way sensitivity, specify both a row and a column input cell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 49 



MSc Induction Programme  Introduction to Advanced Excel 

Oliver Manyemba August 2017 

Example 1 
 

The example below shows a one-way sensitivity analysis for the calculation of an annuity, 

when the interest rate varies from 12-18%. The calculation procedure and results are 

self-explanatory. At the bottom of the example, the same one way sensitivity is performed 

in a row, rather than in a column, to demonstrate the difference between a column and a 

row input cell.  
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Example 2 
 

The example below shows a two-way sensitivity analysis for the calculation of an 

annuity, when both the interest rate and the present value (the loan) vary. A range of 

values for interest rate is given in the first column of the sensitivity table; a range of 

values for the loan value is given in the first row of the table. The top left cell of the table 

contains the formula calculating the parameter that is affected by the changes in the two 

variables. The calculation procedure and results are self-explanatory.  
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12.  Add-ins 
 

In addition to the functions available under its default menus, Excel also comes 

with a number of additional features which expand its capabilities in fields such 

as finance and statistics. 
 

In order to load these: 
 

1. Click the Microsoft Office Button  , and then click Excel Options. 
 

2. Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
 

3. Click Go. 
 

4. In the Add-Ins available box, select the Analysis ToolPak check box, and 

then click OK. 
 

5. If you get prompted that the Analysis ToolPak is not currently installed on 

your computer, click Yes to install it. 
 

 

After you load the Analysis ToolPak, the Data Analysis command is available in the 

Analysis group on the Data tab. Once you have loaded an add-in for the first time, it 

will automatically be loaded every time you start Excel, so there is no need to 

repeat the previous procedure. 
 

Note, however, that the more add-ins you load up the more time Excel takes 

to initialise and the less memory you have available for other operations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In these notes, we will deal with types of add-ins: the Analysis ToolPak, 

which includes Descriptive Statistics and Regression Analysis 
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12.1. Descriptive Statistics 
 

You can generate a series of standardised descriptive statistics for any data series you 

want to statistically analyse. 
 

From the menu select Data => Data Analysis and you will see the dialogue box displayed 

on the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select Descriptive Statistics, click OK and you will see the dialogue box displayed next.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In this box you will need to fill the details of the time series you need to produce the 
descriptive stats for. 
Type in the cell range containing your data and make sure to check Labels in First Row if 

you range also contains the names of the series. 
 

Then choose whether you want the results to be displayed in the same sheet (where 

you will need to specify the top left corner of an empty cell range), in a new sheet or in a 

new Excel file (new workbook) altogether. 
 

Make also sure to tick the box titled Summary statistics, in order for Excel to produce them! 

An example of what kind of statistics are produced is given below. 
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You will note that all of the produced stats are also available as functions, but this add-in is 

a very neat shortcut. Note, however, that the numbers contained in the results are pure 

numbers, NOT formulas, and will not recalculate if any observations change subsequently 

in the series. 

 

12.2. Basic Econometric Analysis: Regression 
 

Regression is one of the commonest econometric tools used to explore the 

relationship between two or more variables. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The variable you are trying to explain is called the 'explained' or 'dependent' variable and is 

normally denoted with 'Y'. 
 

The variable(s) you use to interpret the Y is (are) called the explanatory variable(s) and is 

(are) normally denoted with X (X1, X2, etc.) 
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Although there are several statistical and econometric packages that provide a full array of 

regression tools, Excel also has a convenient (but rudimentary) add-in to let you calculate 

regression results. 
 

Select Tools | Data Analysis and then select Regression, click OK and you will see 

the dialogue box appearing above. 
 

Fill in the cell range containing the dependent (Y) and independent (X) variables, making 

sure to let Excel know if you are including the names of the data series (labels). 
 

As in descriptive statistics, you may paste the results in the same sheet, a different sheet or 

a different file. You may also choose whether Excel displays residuals from the regression, 

whether these residuals are standardised, etc. 
 

An example of what regression calculations Excel can perform for you, look at the example 

below. 
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Key steps in basic econometric analysis 
 

 Create statement of theory/hypothesis


 Collect data


 Specify mathematical model of hypothesis


 Specify econometric model of theory


 Estimate the parameters of the model


 Check model adequacy: test specification


 Test hypothesis derived from model


 Use model for prediction or forecasting
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13.  Graphs 
 

Excel provides a variety of graphs for data analysis and presentation. Both two- and 

three-dimensional charts are provided, including column, bar, line, pie and area charts. 

Before creating a chart, you need to have data on the worksheet, which will be the 

chart’s input. 
 

To create a chart: 
 

Step 1: Click and drag with the mouse to highlight the required range of cells 

(use Ctrl to highlight non-adjacent cells) 
 

Step 2: Click on the Chart Wizard button. A dialogue box titled Chart Wizard - Step 

1 of 4 will appear. 
 

Step 3: Choose the type of the chart that fits your case. You can choose from a 

great variety of chart types and you also have the option to preview your chart by 

simply clicking on the ‘Press and Hold to view Sample’ button. 
 

Step 4: The next dialogue box (Step 2 of 4) asks you to specify the range of the 

data you want to have plotted. If you have already selected the range of data 

you are using, as you have already done, just click Next. 
 

Step 5: In Step 3 of 4 you can turn on and off some standard options for the 

chart you selected. 
 

Step 6: In Step 4 of 4 you specify where you want your chart to be placed. It 

is advisable to place your chart in a new worksheet. 
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A chart type that is widely used to present statistical data is the Pie-Chart. To have your 

data plotted as in the following figure, follow the above mentioned procedure and 

choose Pie when you are asked to define the chart’s type. 
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14. Macros 
 

14.1. Introduction 
 

What is a VBA Macro? 
 

A Macro is a set of instructions that tells Microsoft Excel to perform an action for you. 

Macros are like computer programs, but they run completely within Excel. They allow 

the user of a program to record a series of actions and play them back at a later time. 

In addition Microsoft Excel 97 VBA allows the user to develop his/her own 

programming code using more complex programming logic to create fully functional 

applications. 
 

For example you can create a macro that enters a series of dates across one row of a 

worksheet, centres the date in each cell, and then applies a border format to the row. 
 

When do you need a Macro? 
 

There are two main occasions where the use of Macros offers invaluable help: 
 

When a specific task has to be performed over and over again. 

When functions particular to a user have to be used. 
 

How can a Macro be constructed? 
 

There are two ways to create a macro: 
 

Use the built-in macro recorder 
 

Type the VBA code of the macro directly into the VBA Editor 
 

When the macro recorder is used the VBA code is created into the VBA Editor. 
 

Getting started 
 

Throughout the practise of Visual Basic several operations available on the Excel's menu 

are going to be performed. Shortcut buttons for these operations are available on the 

Visual Basic toolbar. If the Visual Basic toolbar is not displayed on the Excel window you 

can view it by 
 

Step 1: Click-right any toolbar 
 

Step 2: Select Visual Basic 
 

Visual Basic toolbox  
 
 
 

 

Run Macro  
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Runs an existing Macro 
 
 

Record Macro  
 
 

 

Records a series of actions as VBA code 
 

Resume Macro  
 
 

 

Pauses/Resumes recording or running of a Macro 

VB Editor 

 

 

Runs the Visual Basic editor 
 

Control Toolbox  
 
 

 

Initiates the Control Toolbox facility which allows the addition command buttons, 

options buttons, list boxes etc. on a workbook. 
 

Design Mode  
 

 

Switches on/off the Design mode 
 

14.2. Your First Macro 
 

CurrencyFormat 
 

Recording the Macro 
 

Step 1:From the file budget.xls open the Budget97 worksheet and select cells D3:F4. 
 

Step 2: On the VB toolbar click Record Macro and name your macro CurrencyFormat.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Give your Macro a name by typing it in the Macro Name field. Define a Short Cut key that will 

run the Macro in the Short Cut Key field; use Ctrl + Shift rather than Ctrl to avoid conflict 
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with built in functions. Finally store your macro in This Workbook if you want it to be available 

only on this workbook, in the Personal Macro Workbook if you want your Macro to be 

available on any existing or new workbook and in a New if you want it to be available only on a 

new workbook. 
 

Step 3: On the Format menu click the cells command and then the Number Tab. 
 

Step 4: Select Currency from the Category list and type 0 to change the number of Decimal 

places to 0 
 

Step 4: Click the Stop Recording button 
 

Step 5: Save the workbook as Lesson 1. 

 

Running the Macro 
 

Step 1: Open the Budget97 worksheet and select cells D7:F8 
 

Step 2: On the VB toolbar click Run Macro 
 

Step 3: Select the CurrencyFormat and click Run. 

 

Some comments on the code 
 

i. What are the lines with apostrophes? The lines beginning an apostrophe are 

comments which simply are not taken into account when the Macro runs. Use 

comments to distinguish between statements 
 

ii. The macro begins with Sub followed by the name of the macro and ends with End Sub. 
 
iii. Selection stands for the current selection. Number format refers to an attribute of the 

selection. Simply Put : "Let’s ‘$#,##0’ be the number format of selection" Reads from 
RIGHT TO LEFT. 

 
iv. What can you get rid of? Everything apart from the Selection.NumberFormat… 

command. 

 

Practice 
 

For practice you can: 
 

Record a Macro to Merge cells vertically. Can you eliminate the unnecessary lines from 

the macro? 
 

Record a macro to remove gridlines. 
 

Convert a formula to a value. 
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